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Infineon Microcontroller Portfolio Overview

PSoC 

4700/S

PSoC 

4000/T

PSoC 

4100/S/T

PSoC 

4200

PSoC

62

PSoC

64

PSoC

61

XMC

1100

XMC

1200

XMC

1300

XMC

1400

XMC

4100/4200

XMC

4300/4400

XMC

4500

XMC

4700/4800

PSOC 

Edge E84

PSOC 

Edge E83

PSOC 

Edge E81

Cortex-M55/M33 dual-core 

DSP+ ML + GPU

6.5 MB SRAM, .5 MB RRAM

Cortex-M55/M33 dual-core, DSP+ ML 

5.5 MB SRAM, .5 MB RRAM

Cortex-M55/M33 dual-core,                    

DSP+ Peripherals 

5.5 MB SRAM, .5 MB RRAM

XMC 

7100

XMC 

7200

XMCTM 7000 low-power MCUs 
with single- or dual-core M7 are 
built on 40-nm process technology 
addressing high-end industrial 
applications



4Infineon ProprietaryCopyright © Infineon Technologies AG 2024. All rights reserved.2024-05-29

XMC7000 at a glance

▪ Single/ Dual Arm Cortex®-M7 CPU (up to 350-MHz) for primary processing

▪ Arm Cortex®-M0+ (100-MHz) for peripheral & security processing

▪ Up to 105x 16-bit & 16x 32-bit timer/counter pulse-width modulator blocks

▪ Up to 11x reconfigurable Serial Communication Blocks

▪ Up to Up to 220 Programmable I/Os

▪ 3x SAR ADC (up to 1Msps) with up to 57 external channels

▪ Up to 10x CAN FD

▪ Crypto Engine support

▪ 5 different low power modes

▪ Extended voltage operating range: 2.7 to 5.5V

▪ Extended temperature range: -40 to 125°C

➢ Optimal solution for motor control

➢ Cost-optimization & robustness: uses an available 40nm platform

➢ Scalable solution: 2 series, 17 different package-memory combinations

➢ ModusToolboxTM as software development platform

➢ Advanced security options

➢ Power saving for energy-critical applications

✓ Samples already available

✓ Evaluation board already available

✓ Marketing material & Datasheet: 

infineon.com/XMC7000

Product features

Value proposition Availability & material
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ModusToolboxTM
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‒ このドキュメントは、 XMC7200評価キット (KIT_XMC72_EVK) でポテンショメータ(可変抵抗器)の値に応じ

てLEDの輝度を変更するプロジェクトをModusToolbox(開発環境)上で作成する手順を説明するものです。

About this document

https://www.infineon.com/cms/jp/product/evaluation-boards/kit_xmc72_evk/

ポテンショメータ

LED

https://www.infineon.com/cms/jp/product/evaluation-boards/kit_xmc72_evk/
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‒ XMC7200 Manual
XMC7200 Datasheet 32-bit Arm® Cortex-M7
https://www.infineon.com/dgdl/Infineon-XMC-7200-Datasheet-DataSheet-v01_00-EN.pdf?fileId=8ac78c8c8412f8d30184443173374425

XMC7000 MCU family architecture Technical reference manual
https://www.infineon.com/dgdl/Infineon-XMC7000_MCU_FAMILY_ARCHITECTURE_TECHNICAL_REFERENCE_MANUAL-UserManual-v03_00-

EN.pdf?fileId=8ac78c8c850f4bee01859d6b36155cad

XMC7200 MCU registers Technical reference manual
https://www.mouser.com/pdfDocs/Infineon-XMC7200_Technical-reference-manual-UserManual-v01_00-EN.pdf

‒ Application Note
https://www.infineon.com/cms/jp/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc7000-industrial-

microcontroller-arm-cortex-m7/#!documents

AN235616 - Debug XMC7000 MCU in ModusToolbox  environment
https://www.infineon.com/dgdl/Infineon-AN235616_Debug_XMC7000_MCU_in_ModusToolbox_environment-ApplicationNotes-v01_00-

EN.pdf?fileId=8ac78c8c8412f8d3018455dc4b2006ef

AN234282 - Using a SAR ADC in XMC7000 family
https://www.infineon.com/dgdl/Infineon-AN234282-Using_a_SAR_ADC_in_XMC7000_Family-ApplicationNotes-v01_00-

EN.pdf?fileId=8ac78c8c8412f8d3018451d1b5930227

AN234119 - Timer, Counter, and PWM (TCPWM) usage in XMC7000 family
https://www.infineon.com/dgdl/Infineon-AN234119_-_Timer_Counter_and_PWM_TCPWM_usage_in_XMC7000_family-ApplicationNotes-v03_00-

EN.pdf?fileId=8ac78c8c8412f8d301845123daf24f35

AN234226 - XMC7000 MCU: Usage of Interrupts
https://www.infineon.com/dgdl/Infineon-AN234226_-_XMC7000_MCU_Usage_of_Interrupts-ApplicationNotes-v03_00-EN.pdf?fileId=8ac78c8c8412f8d3018451e417060290

Reference

https://www.infineon.com/dgdl/Infineon-XMC-7200-Datasheet-DataSheet-v01_00-EN.pdf?fileId=8ac78c8c8412f8d30184443173374425
https://www.infineon.com/dgdl/Infineon-XMC7000_MCU_FAMILY_ARCHITECTURE_TECHNICAL_REFERENCE_MANUAL-UserManual-v03_00-EN.pdf?fileId=8ac78c8c850f4bee01859d6b36155cad
https://www.infineon.com/dgdl/Infineon-XMC7000_MCU_FAMILY_ARCHITECTURE_TECHNICAL_REFERENCE_MANUAL-UserManual-v03_00-EN.pdf?fileId=8ac78c8c850f4bee01859d6b36155cad
https://www.mouser.com/pdfDocs/Infineon-XMC7200_Technical-reference-manual-UserManual-v01_00-EN.pdf
https://www.infineon.com/cms/jp/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc7000-industrial-microcontroller-arm-cortex-m7/#!documents
https://www.infineon.com/cms/jp/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc7000-industrial-microcontroller-arm-cortex-m7/#!documents
https://www.infineon.com/dgdl/Infineon-AN235616_Debug_XMC7000_MCU_in_ModusToolbox_environment-ApplicationNotes-v01_00-EN.pdf?fileId=8ac78c8c8412f8d3018455dc4b2006ef
https://www.infineon.com/dgdl/Infineon-AN235616_Debug_XMC7000_MCU_in_ModusToolbox_environment-ApplicationNotes-v01_00-EN.pdf?fileId=8ac78c8c8412f8d3018455dc4b2006ef
https://www.infineon.com/dgdl/Infineon-AN234282-Using_a_SAR_ADC_in_XMC7000_Family-ApplicationNotes-v01_00-EN.pdf?fileId=8ac78c8c8412f8d3018451d1b5930227
https://www.infineon.com/dgdl/Infineon-AN234282-Using_a_SAR_ADC_in_XMC7000_Family-ApplicationNotes-v01_00-EN.pdf?fileId=8ac78c8c8412f8d3018451d1b5930227
https://www.infineon.com/dgdl/Infineon-AN234119_-_Timer_Counter_and_PWM_TCPWM_usage_in_XMC7000_family-ApplicationNotes-v03_00-EN.pdf?fileId=8ac78c8c8412f8d301845123daf24f35
https://www.infineon.com/dgdl/Infineon-AN234119_-_Timer_Counter_and_PWM_TCPWM_usage_in_XMC7000_family-ApplicationNotes-v03_00-EN.pdf?fileId=8ac78c8c8412f8d301845123daf24f35
https://www.infineon.com/dgdl/Infineon-AN234226_-_XMC7000_MCU_Usage_of_Interrupts-ApplicationNotes-v03_00-EN.pdf?fileId=8ac78c8c8412f8d3018451e417060290
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ModusToolboxTM overview



9Infineon ProprietaryCopyright © Infineon Technologies AG 2024. All rights reserved.2024-05-29

ModusToolboxTMとは？

› 特徴
– Eclipseをベースに作成されたInfineonの統合開発環境(IDE)

– XMCをはじめPSoCTM, AIROCTM等のInfineon製デバイスをサポート
– コードサイズや機能等の制限無く無償で利用可能
– ツールチェーンによる機械学習, Connectivity, セキュリティのサポート
– GitHubによるサンプルコード, ミドルウェア,デバイスドライバーの提供
– カスタムBSP(ボードサポートパッケージ)作成のためのBSP Assistant

– Infineon Developer Communityによるオンライン技術サポート

ModusToolbox
https://www.infineon.com/cms/jp/design-support/tools/sdk/modustoolbox-software/

Infineon Developer Community
https://community.infineon.com/?category.id=jp

https://www.infineon.com/cms/jp/design-support/tools/sdk/modustoolbox-software/
https://community.infineon.com/?category.id=jp
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Project creation for KIT_XMC72_EVK
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Preparation

› 以下の開発環境をインストールして
ください。
– ModusToolbox 3.2

https://www.infineon.com/cms/en/design-

support/tools/sdk/modustoolbox-software/

› デザインサポートのPCB設計データ
よりKIT_XMC72_EVKの回路図(pdf)

をダウンロードしてください。
https://www.infineon.com/cms/jp/product/e

valuation-boards/kit_xmc72_evk/

Note:回路図はマイコンに接続された外部部品
(LED等)の接続ポート番号の確認等で使用します。

https://www.infineon.com/cms/en/design-support/tools/sdk/modustoolbox-software/
https://www.infineon.com/cms/en/design-support/tools/sdk/modustoolbox-software/
https://www.infineon.com/cms/jp/product/evaluation-boards/kit_xmc72_evk/
https://www.infineon.com/cms/jp/product/evaluation-boards/kit_xmc72_evk/
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1.スタートメニューよりEclipse IDE for ModusToolbox 3.2をクリックして
ModusToolboxを起動します。

2.プロジェクトを格納するワークスペース・フォルダを指定します。
Note:フォルダ名, Pathにマルチバイト文字, スペースを使用しないでください。

3. Launchをクリックします。
Note:End User License Agreementのダイアログが表示された場合はAcceptをクリックしてください。

ModusToolboxの起動

1

2

3
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1. Quick panelのNew Apprication又は、File → New → ModusToolbox Applicationを
選択します。

プロジェクトの新規作成(1/3)

1

1
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2. XMC BSPs(Board Support Package)のKIT_XMC72_EVKを選択しNextをクリッ
クします。

プロジェクトの新規作成(2/3)

2
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3. Getting StartedのEmpty Appをチェックします。
4. New Application Nameに”ADC_PWM_PJ”を設定します(任意指定可)

5. Createをクリックします。

プロジェクトの新規作成(3/3)

3 4

5

Note: Peripherals以下にXMC7200に搭
載されたペリフェラル用のテンプレー
ト(サンプル)が用意されており、各ペリ
フェラルの使用方法を参照する事が出来
ます。
また、WebサイトよりXMC7000シリーズ
のアプリケーションノートを参照できます。
https://www.infineon.com/cms/jp/produ

ct/microcontroller/32-bit-industrial-

microcontroller-based-on-arm-cortex-

m/32-bit-xmc7000-industrial-

microcontroller-arm-cortex-m7/

https://www.infineon.com/cms/jp/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc7000-industrial-microcontroller-arm-cortex-m7/
https://www.infineon.com/cms/jp/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc7000-industrial-microcontroller-arm-cortex-m7/
https://www.infineon.com/cms/jp/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc7000-industrial-microcontroller-arm-cortex-m7/
https://www.infineon.com/cms/jp/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc7000-industrial-microcontroller-arm-cortex-m7/
https://www.infineon.com/cms/jp/product/microcontroller/32-bit-industrial-microcontroller-based-on-arm-cortex-m/32-bit-xmc7000-industrial-microcontroller-arm-cortex-m7/
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› プロジェクトを生成するとModusToolboxパースペクティブ(画面レイアウト)が
表示されます。

ModusToolBoxパースペクティブ

Tool Panel

Project Explorer
プロジェクト構成
ファイルView

Quick Panel
Tool Panel同様の

メニューへのクイ
ックアクセスView

Perspective
(画面レイアウト)の切替

Code editor
コードエディタView

Console / Memory
コンソール / メモリView
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Configuring with Device Configurator
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› プロジェクトには以下の機能を実装します。
– ポテンショメータ(可変抵抗器)の値を12bit SAR ADC(A/Dコンバータ)で取得
– 12bit SAR ADCの値に応じてLEDに接続したTCPWM(PWM)の値を設定

› 12bit SAR ADCやTCPWMといったペリフェラルや、ペリフェラルを動作させる
クロック、LEDに接続するGPIO(I/O)の設定はModusToolboxのDevice

Configuratorを使用して行います。

Device Configuratorの起動

1

2

1. Project ExplorerでADC_PWM_PJプロ
ジェクトをクリックして選択します。

2. Quick PanelでDevice Configurator をク
リックします。

Note: Project ExplorerでADC_PWM_PJプロジェクト
を選択することでQuick PanelにDevice Configurator

が現れます。
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12bit SAR ADCの設定(1/5)

1. Device Configurator の
Peripheralsタブをクリックします。

2. 12bit SAR ADC 0をチェックします。
3. Name(s)に”SARADC_0”を設定し
ます。
Note: Name(s)に設定した名前は、ソース
コード(main.c)からライブラリ(PDL/HAL) を使
用してアクセスする際に、関数の引数として使
用されます(SARADC_0_HW, 
SARADC_0_config等)

4. Enable SAR Blockをチェックしま
す。

5. Clockに”8 bit Divider 0 clk”を設
定します。

1

2 3
4

5
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12bit SAR ADCの設定(2/5)

6. Clockに設定した8 bit Divider 0 

clk の設定を行うため をクリッ
クします。

7. Peri Clock Group 1の8 bit 

Divider 0をチェックし、Name(s)

に“PERI_CLK_1_0”を設定しま
す。

8. Dividerに“16”を設定します。
Note:Divider(分周比)に16を設定する事で
12bit SAR ADC 0の動作クロックが
12.25MHzに設定されます。

9. Peripheralsの をクリックして
12bit SAR ADC 0 の設定画面に
戻ります。

6

7

8

9
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12bit SAR ADCの設定(3/5)

10.Channel 0のEnabledをチェックします。
11.Group Endをチェックします。
12.Inputを”P6[6]”に設定します。

10

11

12
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12bit SAR ADCの設定(4/5)

13.P6[6]の設定を行うため をクリックします。
14.Drive ModeをAnalog High-Z, Input

buffer offに設定します。
15.Analogの をクリックして12bit SAR 

ADC 0 の設定画面に戻ります。

13

14

15
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12bit SAR ADCの設定(5/5)

16.Sample Timeを“8”に設定します。
17.Post Processing Modeを“Averaging”に
設定し、Averaging Countを“1”に設定しま
す。

 

16

17
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TCPWMの設定(1/3)

1. Device Configurator のPinsタブを
クリックします。

2. LED1が接続されているP16[1]を
チェックします。

3. Drive Modeを”Strong Drive, Input 

buffer off” に設定します。
4. Digital Outputを”TCPWM[1] 

Group[0] Counter 61”に設定します。
5. TCPWMの設定に移るため をク
リックします。

1

2

3

4

5

› XMC7000にはTCPWMのChannelが多数搭載されており、出力に接続可能なGPIOは
Channel毎に異なるため、LEDが接続されているGPIOの設定からTCPWMのChannel

を特定します。
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6. TCPWM[1] Group[0] 16bit 

Counter 61をチェックし、
Name(s)に“PWM_1_0_61”

を設定します。Personality

は“PWM-1.0”に設定します。
7. Periodに“65535”を設定し
ます。

8. Compare 0に“0”を設定しま
す。

9. Compare 1に“0”を設定しま
す。

TCPWMの設定(2/3)

6

7

8

9
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TCPWMの設定(3/3)

10.Clock Signal に“8 bit Divider 0 clk”を設定します。
Note: 8 bit Divider 0 clkはSARADCと共用になり、既にDivider(分
周比)の設定は完了しているため、 Dividerの設定は必要ありません。
他のClockを設定する場合はSARADCと同様にDividerを設定します。

11.File -> Saveを選択して設定情報を保存します。
12.Device Configurator のウインドウを閉じて

ModusToolboxに戻ります。
10

11

12
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Device Configuratorで設定されたデータの格納場所

› Device Configurator で設定されたデータはC言語コードで以下の場所に格納されます。
¥ADC_PWM_PJ¥bsps¥TARGET_APP_KIT_XMC72_EVK¥config¥GeneratedSource¥cycfg_peripherals.[c|h]

› また、 Code Previewタブをクリックする事でコードを確認する事が出来ます。
› ユーザーがCodingする際には、このファイルで定義されたデータを使用します。

Note: cycfg_peripherals.[c|h]に定義されたコードと
同様のコードを自分でCodingする事で、Device 

Configuratorを使用せずにプログラムを作成する事
も可能です。
しかし、定義漏れなどが発生する事を避けるため、 

Device Configuratorを使用する事を推奨します。



28

Adding libraries using the Library Manager
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› Debug用にシリアルコンソール上への出力を行うため、 Library Managerを使用
してADC_PWM_PJプロジェクトにretarget-ioライブラリを追加します。

ライブラリ(retarget-io)の追加(1/2)

1

2

1. Project Explorerで
ADC_PWM_PJプロジェクトを
クリックして選択します。

2. Quick PanelでLibrary 

Managerをクリックします。
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3. Add Libraryをクリックします。
4. 検索窓に“retarget”を設定します。
5. Peripheralに表示されるretarget-ioを
チェックします。

6. OKをクリックします。
7. Updateをクリックします。
8. ライブラリの追加が完了すると以下の
メッセージが表示されるので、Close

をクリックしてModusToolboxに戻り
ます。

ライブラリ(retarget-io)の追加(2/2)

3

7

4

5

6

8
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Coding (main.c)
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main.cを表示

1. Project Explorerで
ADC_PWM_PJプロジェクトの
main.cをダブルクリックして
main.cファイルを開きます。

1
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2. main.cに以下の関数をCodingします。
– main()関数：MCU, ペリフェラルの初期化、割り込み設定、12bit SAR ADCソフトウェアトリガ発行
– saradcIntHandler()：割り込み要因の確認、AD変換値のコンソール出力・TCPWMへの設定、ADCソフ
トウェアトリガ再発行

main.cのCoding

main()

BSPの初期化
IRQ割り込み許可

retarget-ioの初期化
割り込み要因 == 

AD変換完了？
TCPWMの初期化

SARADCの初期化

割り込みハンドラの登録

SARADCのソフトウェア
トリガの発行

saradcIntHandler()

割り込み要因の読み出し

Return

AD変換値の読み出し

AD変換値のコンソール出力
AD変換値<<4をTCPWM比較値に設定

SARADCのソフトウェア
トリガの発行
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main.c(1/4)

/*******************************************************************************
* File Name:   main.c
* Measure potentiometer with SARADC
*  and set the measured value to PWM to change LED brightness
*******************************************************************************/

/*******************************************************************************
* Header Files
*******************************************************************************/
#include "cy_pdl.h"
#include "cyhal.h"
#include "cybsp.h"
#include "cy_retarget_io.h"

/*******************************************************************************
* Macros
*******************************************************************************/

/*******************************************************************************
* Global Variables
*******************************************************************************/
/* SARADC interrupt configuration structure */
cy_stc_sysint_t SARADC0_IRQ_cfg  = {
    /* Bit 0-15 of intrSrc is used to store system interrupt value and bit 16-31 
to store CPU IRQ value */
    .intrSrc = ((NvicMux2_IRQn << 16) | pass_0_interrupts_sar_0_IRQn),
    /* Interrupt priority */
    .intrPriority = 7
 };

› cy_pdl.hはPDL, cyhal.hはHALのIncludeファイル
です(詳細は後述)

› Cybsp.hはBSP(ボードサポートパッケージ)に関
連したIncludeファイルです。

› Cy_retarget_io.hはRetarget-ioライブラリをア
クセスするために指定します。

› SARADC0_IRQ_cfgはCy_SysInt_Init()関数の引
数として使用されます。

› intrSrcにシステム割り込み元、CPU IRQを指定し、 
intrPriorityにCPU IRQ優先度を設定します。



35Infineon ProprietaryCopyright © Infineon Technologies AG 2024. All rights reserved.2024-05-29

main.c(2/4)

/*******************************************************************************
* Interrupt routines for SARADC
*******************************************************************************/
void saradcIntHandler(void) {
uint32_t val;

    if( Cy_SAR2_Channel_GetInterruptStatus(SARADC_0_HW, SARADC_0_channel_0_IDX ) == 
CY_SAR2_INT_GRP_DONE){
        // Clear interrupt
        Cy_SAR2_Channel_ClearInterrupt(SARADC_0_HW, SARADC_0_channel_0_IDX, 
CY_SAR2_INT_GRP_DONE);
        val = (uint32_t)Cy_SAR2_Channel_GetResult( SARADC_0_HW, SARADC_0_channel_0_IDX, 
NULL );
        printf("SARADC Value:%d¥r", (int)val );
        // Set the measured value to PWM 
        Cy_TCPWM_PWM_SetCompare0Val( PWM_1_0_61_HW, PWM_1_0_61_NUM, val<<4);
        // Start next AD-Conversion
        Cy_SAR2_Channel_SoftwareTrigger(SARADC_0_HW, SARADC_0_channel_0_IDX);
    }else{
        CY_ASSERT(false);    // Unexpected interrupt
    }
}

› ステータスレジスタを参照して割り込み要因が
AD変換完了であるかを判定し、割り込み要因の
クリアを行います。

› AD変換値(0～4095)を読み出し、コンソールに
出力します。

› AD変換値(0～4095)を、4bit左シフトしてPWM
のCompare値(0～65535)に設定します。

› ソフトウェアトリガを発行して次のAD変換をスタ
ートします。
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main.c(3/4)

/*******************************************************************************
* main
********************************************************************************/
int main(void){
cy_rslt_t result;

    /* Initialize the device and board peripherals */
    result = cybsp_init();

    /* Board init failed. Stop program execution */
    if (result != CY_RSLT_SUCCESS){
        CY_ASSERT(0);
    }

    /* Enable global interrupts */
    __enable_irq();

    /* Initialize retarget-io to use the debug UART port */
    result = cy_retarget_io_init(CYBSP_DEBUG_UART_TX, CYBSP_DEBUG_UART_RX,
                                 CY_RETARGET_IO_BAUDRATE);

    /* retarget-io init failed. Stop program execution */
    if (result != CY_RSLT_SUCCESS){
        CY_ASSERT(0);
    }

    /* Print message */
    /* ¥x1b[2J¥x1b[;H - ANSI ESC sequence for clear screen */
    printf("¥x1b[2J¥x1b[;H");
    printf("-----------------------------------------------------------¥r¥n");
    printf(" Measure potentiometer with SARADC ¥r¥n");
    printf(" and set the measured value to PWM to change LED brightness¥r¥n");
    printf("-----------------------------------------------------------¥r¥n¥n");

› 最初にcybsp_init()関数を呼び出すことで
Deviceの初期化を行います。

› __enable_irq()関数によりマイクロコントロー
ラの割り込みを有効化します。

› cy_retarget_io_init()関数により標準入
出力をシリアルポートにマップします。

› シリアルターミナルを以下のように設定する事
でprintf()関数などを使用して出力する事が
可能です(Port番号は環境により異なるため省
略します)

 Baud rate: 115200

 Data: 8bit

 parity: None

 Stop bit: 1

 Flow Control: none 



37Infineon ProprietaryCopyright © Infineon Technologies AG 2024. All rights reserved.2024-05-29

main.c(4/4)

    /* TCPWM Init */
    Cy_TCPWM_PWM_Init(           PWM_1_0_61_HW, PWM_1_0_61_NUM, &PWM_1_0_61_config );
    Cy_TCPWM_PWM_Enable(         PWM_1_0_61_HW, PWM_1_0_61_NUM );
    Cy_TCPWM_TriggerStart_Single(PWM_1_0_61_HW, PWM_1_0_61_NUM );

    /* SARADC Init */
    Cy_SAR2_Init(           SARADC_0_HW, &SARADC_0_config);
    Cy_SAR2_Enable(         SARADC_0_HW );
    Cy_SAR2_Channel_Init(   SARADC_0_HW, SARADC_0_channel_0_IDX, 
&SARADC_0_channel_0_config );
    Cy_SAR2_Channel_Enable( SARADC_0_HW, SARADC_0_channel_0_IDX );

    /* Clear whole interrupt flags */
    Cy_SAR2_Channel_ClearInterrupt(SARADC_0_HW, SARADC_0_channel_0_IDX, CY_SAR2_INTR);

    /* Masking interrupts other than CY_SAR2_INT_GRP_DONE */
    Cy_SAR2_Channel_SetInterruptMask(SARADC_0_HW, SARADC_0_channel_0_IDX, 
CY_SAR2_INT_GRP_DONE);

    /* Set Interrupt  */
    Cy_SysInt_Init( &SARADC0_IRQ_cfg, saradcIntHandler );
    NVIC_ClearPendingIRQ( (IRQn_Type)(SARADC0_IRQ_cfg.intrSrc >> 16) );
    NVIC_EnableIRQ(       (IRQn_Type)(SARADC0_IRQ_cfg.intrSrc >> 16) );

    Cy_SAR2_Channel_ClearInterrupt(  SARADC_0_HW, SARADC_0_channel_0_IDX, 
CY_SAR2_INT_GRP_DONE );
    Cy_SAR2_Channel_SoftwareTrigger( SARADC_0_HW, SARADC_0_channel_0_IDX );

    for (;;){}

}

/* [] END OF FILE */

› TCPWMの初期化を行います。

Note:引数に指定されているパラメータは
cycfg_peripherals.[c|h]で定義されています。

› SARADCの初期化を行います。

› 割り込み要因のクリアを行います。

› AD変換完了割り込み以外をMaskします。

› 割り込みハンドラの登録とNVICへの設定を行
います。

› ソフトウェアトリガを発行し、AD変換を開始しま
す。
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PDL/HAL Reference格納場所について

› Coding を行う際にペリフェラルを制御するライブラリとして、PDL(Peripheral driver 

library)とHAL(Hardware Abstraction Layer)の2種類が提供されます。

› PDLはハードウェアを使いやすい API のセットに抽象化したライブラリで、HALはPDLを
使用して構築された更に抽象度の高いライブラリとなります。
Note:PDLとHALは共存が可能です。

› Codingで使用するPDL/HAL APIのReferenceはHTMLファイルとして以下に格納されて
おりWebブラウザで参照可能です。

PDL: ¥KIT_XMC72_EVK_WS¥mtb_shared¥mtb-pdl-cat1¥release-v3.8.0¥docs¥pdl_api_reference_manual.html

HAL: ¥KIT_XMC72_EVK_WS¥mtb_shared¥mtb-hal-cat1¥release-v2.5.4¥docs¥api_reference_manual.html
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Build & Program
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› ProjectのBuildを行った後、Debuggerを起動してBuildしたProjectを
KIT_XMC72_EVKに書き込んでDebugを行います。

ProjectのBuild

1. Tool PanelのSaveをクリックし
てmain.cを保存します。

2. Project -> Build Projectを選択し
てProjectをBuildします。

3. Buildが完了したらConsoleを確認
してErrorが無い事を確認します。
Errorがある場合はProblemsタブ
をクリックして詳細を確認し、修正
した後、再度Buildを行います。

1

2

3
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1. ModusToolboxを動作させているPCとKIT_XMC72_EVKをKit付属のUSB Type-A - Mirco-Bケーブルで接続し

ます。

2. 付属の12V/3A DC電源アダプタを接続します。

KIT_XMC72_EVKの準備

1

2 DCアダプタを接続

Note: USBからの電力供給は５００ｍA

までとなり、電力が不足する場合がある
ため、DCアダプタは必ず接続してださ
い。

PCのUSBに接続
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1. Debugアイコン の横の▼をクリックしてDebug Configurationを選択します。
2. GDB OpenOCD DebuggingのADC_PWM_PJ Debugをクリックします。
3. Debug Configurationsに表示が変化するのでDebugをクリックします。

Debug(1/12)

1

3

2

Note: 2度目以降はDebugアイコン をクリックする事で
Debuggerが起動します。
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› Debugパースペクティブへの切り替えを行います
› ModusToolboxパースペクティブのままDebugを行う事も可能ですが、Debugger

使用時に適したDebugパースペクティブへの切り替えを行います。
4. PerspectiveのOpen Perspectiveアイコンをクリックします。
5. Open Perspectiveダイアログが表示されますのでDebugを選択してOpen

をクリックします。

Debug(2/12)

4
5

Note: 2度目以降はDebug Perspectiveアイコンが
表示されるのでアイコンをクリックする事で
Perspectiveを切り替えられます。
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› Debug Perspectiveは以下のようになります。

Debug(3/12)

1

Debug View
Debugのスレッド情報

表示

Debugger Action
プログラムの実行/停止

操作アイコン

Editor View
ソースコードレベルで
の実行位置表示及びブ
レークポイントの設定/

解除

Variable/Breakpoint 

View
変数/ブレークポイント
の監視及び設定

Memory/Register 

View
メモリー/レジスタの監

視及び変更
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› 主なDebugger Actionアイコンは以下の通りです。

Debug(4/12)  Debugger Actionアイコン一覧

アイコン 名称 説明

Skip All Breakpoints ブレークポイントを無効化します。ブレークポイントの削除は行いません。
クリックする度にEnableとDisableをトグルします。

Resume プログラムを連続実行します。

Suspend 実行中のプログラムを停止します。

Terminate デバッガーを停止します。
ModusToolbox  パースペクティブに移動する前に必ず停止してください。

Step Into クリックする度に1ステートメントを実行しますが、実行するステートメントに関
数が含まれている場合、その関数内部に移動します。

Step Over 実行するステートメントに関数が含まれている場合、その関数内部の全てのステー
トメントを実行します。

Step Return 現在実行中の関数の呼び出し元まで全てのステートメントを実行します。

Restart Resetが行われ、main()関数先頭のステートメントに戻ります。
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› Debugセッションが開始されるとプログラムが書き込まれ、main()関数先頭のス
テートメントまで自動的に実行されます。
Note: main()関数の先頭に自動的にブレークポイントが設定されます。このブレークポイントは
Debugger ConfigurationのStartupタブにあるSet Breakpoint at:の項目で指定されています。

Debug(5/12)
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6. Debugger ActionのStep Into アイコンをクリックします
main()関数内の最初のステートメントまで実行されたことを確認します。

7. 再度Debugger ActionのStep Into      アイコンをクリックします
Editor Viewにcybsp.cが表示され、cybsp_init()関数内の最初のステートメントまで実行されたことを確認します。

Note: Step Into アイコンはクリックする度に1ステートメントを実行しますが、実行するステートメントに関
数が含まれている場合、その関数内部に移動します。

Debug(6/12)

6

7
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8. Debugger ActionのStep Return  アイコンをクリックします
cybsp_init()関数の残りのステートメントが全て実行され、main()関数のcybsp_init()関数呼び出しステート
メントの次まで戻っていることを確認します。ソースコードのresultにマウスカーソルを合わせる事でresult

に格納された値を確認する事が可能です。

9. 再度Debugger ActionのStep Into      アイコンをクリックします
main()関数内の次のステートメントまで実行されたことを確認します。

Debug(7/12)

8

8

9
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10.Debugger ActionのStep Over アイコン をクリックします
__enable_irq() 関数内に移動せず、次のステートメントまで実行されたことを確認します。

11. Editor Viewのスクロールバーをドラッグしてmain.cのsardcIntHandler()関数内の、
Cy_TCPWM_PWM_SetCompare0Val()関数呼び出し行の先頭をダブルクリックします。

Cy_TCPWM_PWM_SetCompare0Val() 関数呼び出し行にbreakpointが設定されたことを確認します。

Debug(8/12)

10

11

11
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12.Debugger ActionのResumeアイコン をクリックします
Breakpointを設定したCy_TCPWM_PWM_SetCompare0Val() 関数呼び出し行まで実行されたことを
確認し、Variable/Breakpoint Viewに変数valが表示されている事を確認します。

13.Variable/Breakpoint Viewの変数valのValueをクリックし、”0 ”を入力してEnterを
押した後、 Debugger ActionのResumeアイコン をクリックします
再度breakpointまで実行されたことを確認し、 KIT_XMC72_EVKのLED1が点灯している事を確認します。

Note:変数valの値（value）はポテンショ
メータの位置により、0～4095の値になり
ます。

Debug(9/12)

12 12

13
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14.Variable/Breakpoint Viewの変数valのValueをクリックし、”4095”を入力して
Enterを押した後、 Debugger ActionのResumeアイコン をクリックします
再度breakpointまで実行されたことを確認し、 KIT_XMC72_EVKのLED1が消灯している事を確認します。

15.Debugger Action のSkip All Breakpointsアイコン をクリックし、 Resumeアイコン
をクリックします

ResumeアイコンがDisable になり、実行状態が継続している事と、ポテンショメータを回してLED1の輝度が変化す
る事を確認します。

Debug(10/12)

Note:再度クリックするとアイコンの色が戻りDisableとなります。

14
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16.Debugger ActionのSuspend アイコン をクリックします
ResumeアイコンがEnable になり、停止状態に移行している事と、ポテンショメータを回してもLED1

の輝度が変化しない事を確認します。

17.Debugger Action のRestart アイコン をクリックします
Resetが行われ、main()関数先頭のステートメントに戻ったことを確認します。

Debug(11/12)

18.Debugger ActionのTerminate アイコン をクリックします
Debugger ActionのアイコンがDisableし、Debug ViewのスレッドがTerminateされていることを確認し
ます。

17

18

18
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Debug(12/12)

19.PerspectiveのModusToolbox Perspectiveアイコン をクリックしてDebugセッ
ションを終了します

Note:Debugセッションを終了する際は必ずTerminateしてください。

19
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XMC7000 Sensor-less Motor Control
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Block Diagram

XMC7000XMC7000 CM7

XMC7000 MCU

Target ω
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‒ The configuration of the peripheral is shown below.

‒ TCPWM 16-bit counters for Motor Control (U/V/W: 3 ch)

‒ ADC (U/V/W: 3 unit)

‒ Trigger Multiplexer

XMC7000 Peripheral Configuration

Trigger Multiplexer 

for Synchronous 

Start

TCPWM (U phase)

Adds dead time

Trigger Multiplexer 

for ADC Trigger
SAR ADC

U phase

SAR ADC

V phase

TCPWM (V phase)

Adds dead time

TCPWM (W phase)

Adds dead time

SAR ADC

W phase

Software

Start

ADC Trigger 

UH

UL

WH

WL

VH

VL

U phase Current

V phase Current

W phase Current
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Time chart for motor control

‒ There are three TCPWM to generate PWM for 

U, V and W

‒ The TCPWM for V and W are not shown here

‒ Dead time insertion are introduced to line_out 

and line_compl_out of TCPWM for U, V and W

‒ The three ADC are triggered synchronously at 

under flow of TCPWM for U

‒ Once the ADC sampling are done, the ADC 

ISR (Interrupt Service Routine) will be 

triggered, and Torque control loop is then 

performed in the ISR

for example
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Appendix
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Device Configurator setting value for SARADC
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Device Configurator setting value for TCPWM
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Device Configurator setting value for GPIO P6[6], P16[1]
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Device Configurator setting value for Peripheral Clock
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